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mercury loadrunner

quicktestpro testdirector
mercury
1)

Mercury winrunner quicktestpro
c VBscript

c/s b/s

vb vc delphi pb java
winrunner
.net

quicktestpro mercury web

2)

j2ee



www.51testing.com

Mercury
loadrunner
75
loadrunner loadrunner
3)
testdirector
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mercury
mercury
gartner
mercury IBM
rational compuware mercury
mercury

mercury

Magic Quadrant For Application Quality Ecosystem

Application Quality E cosystem MO

Challenger Leader

A bility to Execu

Completeness of Wision e

Micke

Source: Gartner Research
mercury

loadrunner

webload silkperformer
loadrunner
loadrunner quicktestpro web
gawizard XDE Tester
blog

testdirector
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1)

2)

mercury CPE certification
product education mercury
mercury
3 mercury
CPE

CPS(certification  product specialist)
CPC(certification product consultant)

mercury

mercury

mercury www.51testing.com

ing
2005 7 5
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SA System Administrator ,
DBA DataBase Administrator

DBA

1 A: 5,000,000
B:

2 60%

3 C: 50

4 D: 8

5 E: 6

6 F: ( ) 4

7 G: 50%

8 H: 6

9 J: (K) 30|Kbyte
K1: WEBMAIL

10 70%

11 K2: 28%

12 K3: IMAP 2%
L: web

13 : 4

14 M: 30|Kbyte

15 N: 75%

1 18
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16 O: 25%

17 Q: CPU 60%

19 POP =A*K2*B*D*G/(F*3600) 52.78 /

20 POP POP *J) 1.58Mbyte/s
HTTP

21 =A*K1*B*D*G/(F*3600) 83 /
HTTP

22 =A*K1*B*D*G/(F*3600) 62.5 /
HTTP * *

23 HTTP ) 9.96(Mbyte/s

24 HTTP HTTP *J) 1.88|Mbyte/s
SMTPIN(

25 =A*K2*B*D*G/(F*3600) 52.78 /
SMTPCLIENT(

26 )=A*B*E*G/(F*3600) 104.17) /
SMTPOUT(

27 =A*B*E*G*N/(F*3600) 78 /
SMTP

28 SMTPIN+SMTPCLIENT+SMTPOUT) 134 /

29 SMTP =(SMTPIN+SMTPCLIENT)*J 4.68Mbyte/s

30 SMTP =(SMTPOUT*J) 2.03|Mbyte/s

31 6.56|Mbyte/s

32 13.57Mbyte/s

33 20.13Mbyte/s

34 =< 8( ) 160|Mbit/s

35
POP =A*K2 * B*H*G/(F*3600)

36 / 39.58| /
SMTP

37 =A*B*(D+E)*G/(F*3600) / 183.06| /
HTTP =A*B*

38 (D+E)*K*L*G*O/(F*3600) / 145 /
IMAP

39 =A*D*K3*B*I1*G/(F*3600) / 0.35 /

webmail,smtp,pop webmail 70%,
30%,
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ACT WAS LoadRunner

LoadRunner
QQ
web session,cookie
10
SQL
DBA
DBA
tuning
tuning
tuning
IBM-Quantify
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MS-SQL

TestDirector
TestDirector

MS-SQL ->

www.testage.net 7 ““51Testing

TestDirector MS-SQL
1
MS-SQL
MS SQL Server DB
Server DB Server
TestDirector DB Server Project
o DB Server TestDirector SQL
Server
® DB Server TestDirector
[ ) SQL Server SQL Server
2
————1 24
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IP
1

SQL Server2K

sa
sa TestDirector7.6 SQL Server2000

1 DB Server TestDirector
SQL Server

TestDirector
SQL Server2000

TestServer DB Server

http://tdserver/tdbin/SiteAdmin.htm
TestDirector DB Server New
DB Server 1
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Define New Database Server x|

— Database Type

&1 M5-SQL 1 Svbaze 1 Oracle

— Database ¥alues

Server Alias : |Test5erver

DB Admin User |ssl |

DB Admin Passwiord : |*>'c | Retype Passward |**|

— Defanlt Conmection String

Provider=SQLOLETE. 1;Data Source=¥IE_SERVERY; User d
ID=%DE_USER%: Faz=wor d=%FASSWORD%; Ini tial Catalogz=%DE_HAME%

1I Fing
0K H Cancel
1
Ping OK Server Alias 192.168.0.2
DB Server ping
MS-SQL Project
Projects Creat ““Creat Project””

——1 26
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Create Projeckt

Project Mame : |FromTe5tServer| |

In Damain: | DEFAILT [~]

r Databaze Type

) M3 Accaess #1 M3-SQL

() Oracle (71 Syhase

2

Next TestServer

Creakte Projeckt

Server Mame |TestServer |v|

DB Admin User : |=a |

DB Admin Passward |** |

< v ][5 e |

3
Next MS-SQL TD
FromTestServer
1 SQL Server2000
MS-SQL DB Server MS-SQL

——1 27
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Project TestDirector SQL
Server
2 TestDirector DB Server
DevServer
MS-SQL DB Server
DB Server 4

Define New Database Server x|

— Datahase Type

(% M3-SAL ) Syhaz=e 1 Oracle

— Database ¥alues

Semer Alias : |DevServer

DB Admin User : |sa |

DB Admin Password : |** | Retype Password @ [+

 Default Conmection String

FProwider=SQL0OLEDE. 1;Data Sewrce=%0E_SERVER%; U=zer ;I
ID=%0E_USER%:Fasswor d=%FASSWORD%; Initial Catalogz=%0E_NAME%

&
LI Fing
g ‘ Cemeil ‘
4
Ping —_— ping
SQL Server SQL Server
“ 1 7z SQL Server
DB Server
Server Alias
““DevServer\Dev~~
\
““DevServer\Dev~”” ping
SQL Server DB Server

——1 28
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SQL Server
SQL Server
TestDirector MS-SQL
Project
TestDirector
TestDierctor SQL Server
#%

TD SQL Server
DB Server

TDServer SQL Server
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2 SOL Server Client Nebwork Utility x|
General Hlias |DB-Library Options I Fetwork Libraries
Server alias configurations
Server alias | Hetworlk lib. .. | Connectlon parameters
dbiEs TCE/IF 10. BB, 245, 55, 1433
Devlopment TCE/IF 10.66. 245. 85, 1433
=qlE5 TCE/IF 10. BB, 245, 55, 1433
TODESERVERID TCE/IF betd-fuxinhtest
TIDESERVERZ0 TCE/IF 10, BB, 248, 204 test
test TCE/IF 10.66. 245. 85, 1433 Eemowe |
Edit. .. |
1| |
wmE | mm | mEw | #=m |
Add ““TCP/IP>~
SQL Server TestServer
£ add Network Library Configuration |
Server alias: Te=t
—HWetwork libraries——————— ~Comnection parameters
" Hamed Fipes Server name: ITestServer
{* TCR/IP
" Multiprotocel [~ Dymamically determine port
" HWLink IFX/SEX Fort mumber: |1433
{ AppleTalk
{~ Banyan ¥INES
" VIA
{ Other

0K I Cancel Help

SQL Server DevServer

——1 30
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8 Add Network Library Configuration x|
Server alias: I]]eveﬂ.opment
—Hetwork libraries —Connection parameters
(" Wamed Fipes Server name: I]JevServer\Dev
{* TCR/IP
" Multiprotocol [~ Dynamically determine port
{~ W¥Link IPX/SFX Port mumber: I1433
{~ AppleTalk
{~ Banyan YINES
" VIA
" Other
[1):4 I Cancel Help

TestDirector

2 DB Server

““Test” <““Development”” DB Server
DB Server MS-SQL Project
3 SQL Server TD
SQL ““Server name”’ SQL Server
IP
4 SQL Server TD
SQL ““Server name”” SQL Server
“ P\ i
5 TestDirector SQL
TD DB Server
SQL TD
MS-SQL
3
“e MS-SQL TD 7z
“ 7z TD
1) TestDirector SQL Server
——1 31
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2)

3)

4)

5)

6)

SQL Server
TestDirector

SQL Server
DB Server
IP

““Server Alias””

SQL Server
DB Server
P\

TestDirector

SQL
4,,

TD7.6

TestDirector

TestDirector

Email snowers@sina.com QQ 6440520

““Server Alias®?

DB Server

TestDirector
SQL Server

TestDirector
SQL Server

SQL

£ c 3,’ cc

TD8.0
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Loadrunner web_reg save_param

Mercury LoadRunner
HTML

Mercury LoadRunner

Loadrunner
web

web_reg_save_param

int web _reg save param(const char *ParamName, <list of
Attributes>, LAST);

1) ParamName:
2) list of Attributes: Notfound, LB, RB,
RelFramelD, Search, ORD, SaveOffset, Convert, Savelen
» Notfound:
» Notfound=error:
» Notfound=warning:
» LB( Left Boundary ) :

» RB( Right Boundary ):

> RelFramelD: URL Frame
All
——1 33
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» Search : Headers Body
Noresource All( )
» ORD :
1 All

> SaveOffset

0
» Savelen
-1
» Convert : :
HTML_TO_URL : HTML-encoded URL-encoded
HTML_TO_TEXT : HTML-encoded
3
1) URL based script
x|

 Intemnet Pratacol Intemet Pratocal: Recording

cording
- Browser

Recording Level

Recording Prasy
- Advanced oe " HTHL-based script HITKL dvanced... |
i Comelation B=
& URL-based script URL Advanced.. |
Hint:

Move the mouze aver ahy item to zee itz description.

ak I Cancel Usze Defaults Help

2)

——1 34
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Run-time Settings

|

General: Log

- General
Fur Logic

¥ Enable logging

Log options

H | " Send messages only wheh an emor ocours Adyaticed.. |
- Miscellaneous &Y

Network {* Always zend messages

i Speed Simulation Log meszages at the detail level of
B:TUWSB' " Standard log

i Browser Emulation

&

- Internet Pratocal * Eytendedlog

- Prowy [ Parameter substitution

i Preferences

W

- ContentCheck ¥ Data retumed by server

[~ Advanced trace

Hint
Move the mouse aver any item to see itz dezcription.

K I Cancel Usze Defaults Help

3) URL

RS |
faaih | BIEREF ( ADSL/LA)
FEREMNE |ER

BHEERS: | G O BPus CaBEs O FREE
1BREE : |

35
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st AN R

2ER D0 ZLf
ERE FI0EE
Hihk: http:/ A - - 1= i ez sAccept ord

(IEL] er/modi fyllfferinzStatelaze do?
R R 8353 =8

fil[3ATE . 2005-1-18
{EoaEtiE . 2005-1-13

E+ ) |
mE | BE | EAw |

URL

web_url("modifyOfferingStatePage.do”,"URL={url}/web/busines
sAccept/order/modifyOfferingStatePage.do?offeringld=282172&
offeringSpecld=1&offeringSpecName= ADSL/LAN
&customerName={clientname}&nodeld=260000&posl=

&pos2= ,
"Resource=0",
"RecContentType=text/html",
"Referer={url}/web/businessAccept/order/orderMenu.do",
"Snapshot=t23.inf",

"Mode=HTTP",

LAST) ;

web_reg_save_param(“oldstate",
"LB/IC= </td>",
"RB/IC=</td>",

"Search=body",

"Ord=1",
— 1 36
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"RelFrameld=1",
"SaveOffset=57",
"SavelLen=4",
LAST) ;

web_url("modifyOfferingStatePage.do”,"URL={url}/web/busines
sAccept/order/modifyOfferingStatePage.do?offeringld=282172&
offeringSpecld=1&offeringSpecName= ADSL/LAN
&customerName={clientname}&nodeld=260000&posl=

&pos2= ",

"Resource=0",

"RecContentType=text/html",
"Referer={url}/web/businessAccept/order/orderMenu.do",
"Snapshot=t23.inf",

"Mode=HTTP",

LAST) ;

//

Ir_log_message("getvalue : %s™,Ir_eval _string
("{oldstate}"));

if ( Ir_eval_string ("{oldstate}") == " "){
web_submit_data("modifyOfferingState.do",

"Action={url}/web/businessAccept/order/modifyOfferingSta
te.do",

"Method=POST",
"RecContentType=text/html",

"Referer={url}/web/businessAccept/order/modifyOfferingSt
atePage.do?offeringld=282172&offeringSpecld=1&offeringSp
ecName= ADSL/LAN
&customerName={clientname}&nodeld=260000&posl=

&pos2= ",

"Snapshot=t24_inf",

"Mode=HTTP",

I TEMDATA,

"Name=offering.state", "Value=1", ENDITEM,

1 37
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"Name=offering.recentModifyReason™, "Value= ",
ENDITEM,

"Name=offering.customerld”™, "Value=281218", ENDITEM,
"Name=offering.offeringld”, "Value=282172", ENDITEM,
"Name=offering.offeringSpecld™, "Value=1", ENDITEM,
"Name=offering.recentMender™, "Value=root™, ENDITEM,

"Name=offering.recentModifyDatetime™, "Value=2005-01-16",
ENDITEM,

"Name=nodeld"™, "Value=260000", ENDITEM,
"Name=customerName", "Value={clientname}", ENDITEM,

"Name=offeringSpecName™, "Value= ADSL/LAN ™,
ENDITEM,

"Name=submit.x", "Value=33", ENDITEM,
"Name=submit.y", "Value=13", ENDITEM,
LAST);

}

Else
{
web_submit_data("modifyOfferingState.do",

"Action={url}/web/businessAccept/order/modifyOfferingSta
te.do",

"Method=POST",
"RecContentType=text/html",

"Referer={url}/web/businessAccept/order/modifyOfferingSt
atePage.do?offeringld=282172&offeringSpecld=1&offeringSp
ecName= ADSL/LAN
&customerName={clientname}&nodeld=260000&posl=

&pos2= ",

"Snapshot=t24._inf",

"Mode=HTTP",

ITEMDATA,

"Name=offering.state”, "Value=0", ENDITEM,

"Name=offering.recentModifyReason™, "Value= ",
ENDITEM,

"Name=offering.customerld”™, "Value=281218", ENDITEM,

1 38
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"Name=offering.offeringld”, "Value=282172", ENDITEM,
"Name=offering.offeringSpecld™, "Value=1", ENDITEM,
"Name=offering.recentMender™, "Value=root™, ENDITEM,

"Name=offering.recentModifyDatetime™, "Value=2005-01-16",
ENDITEM,

"Name=nodeld"™, "Value=260000", ENDITEM,
"Name=customerName", "Value={clientname}", ENDITEM,

"Name=offeringSpecName™, "Value= ADSL/LAN ™,
ENDITEM,

"Name=submit.x", "Value=33", ENDITEM,
"Name=submit.y", "Value=13", ENDITEM,

LAST);
}
vuser_init.c(689): <tr
bgcolor="#F6F6F6">\r\n
vuser_init.c(689): <td

width="30%" height="23" align="right">\r\n

vuser_init.c(689):
</td>\r\n

vuser_init.c(689): <td
width="70%" height="23"> </td>\r\n

vuser_init.c(689): </tr>\r\n

vuser_init.c(689): <tr
bgcolor="#FAFBFE">\r\n

vuser_init.c(689): <td
width="30%" height="23" align="right">\r\n

vuser_init.c(689):
</td>\r\n

vuser_init.c(689): <td
width="70%" height="23">\r\n

vuser_init.c(689): \r\n
vuser_init.c(689): \r\n
vuser_init.c(689): \r\n

vuser_init.c(689): <input
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type="radio"” name="offering.state” value="4" checked>

</td> </td>
57 4 2

4
1
2)
Ir_log message("getvalue
%s",lr_eval _string ("{oldstate}"));
3)

4) vuser_init.c(734): Error -27190: No match found for the
requested parameter "oldstate"”. Check whether the requested
boundaries exist in the response data. Also, if the data you
want to save exceeds 1024 bytes, use
web_set_max_html_param_len to 1increase the parameter
size [Msgld: MERR-27190]

5) vuser_init.c(734): Error -27187: The above "not found"
error(s) may be explained by header and body byte counts
being 0 and 0, respectively. [Msgld: MERR-27187]

6) vuser_init.c(734): web_concurrent_end highest severity
level was "ERROR™ [Msgld: MMSG-27181]

7

8)

—] 2
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Recording Options
Internel Pratocol

Recording
Browser

i Comelation

R B .

41



www.51testing.com

51testing
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3
1
Microsoft
2

Compuware Empirix

1000

Java

Apache
IBM
Eclipse

.NET

Mercury Segue IBM Rational

Jmeter Jtest OpenStar
IBM
JBuilder
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TPTP
Eclipse

SIT(System

Integration TestCase)

SIT
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TestDirector ( )

TestDirector  Mercury Interactive WEB

Part 11

TestDirector
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Define Testing
Scope

Create
Requirements

Detail
Requirements

Analyze
Requirements

el

TestDirector
TestDirector
TestDirector Administrator’s Guide

6.1.

Goal Objective Strategy

— 8
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6.2.

QA QA

TestDirector

Document Yiew Ea

& Application Security

& Application Client System
& Application Usability

& Application Performance
« Application Reliability

# Profile Management

# Booking System

# Flights Reservation Senvice
# Reservations Management
QA

Ul

TestDirector_Demo

8 [ ¥
Developing the Requirements Tree

6.3.

QA
Application Security

49



www.51testing.com

= 2 - Application Security
+ 2.1- Access Authorization
[+ 2.2 - Secure Transmission
[+ 2.3 - Privacy Protection
+ 2.4 - Data Storage Protection
= 2.5 - Third Party Security Compliance

Requirement — = 2,5.1 - Airline Companies
topic BEBE 2511 - Blue Skies Ajrlines
Regquirement ——— 2.51.2 - Pangea Airlines
children EHE 2.51.3 - Uniified Airlines

H 2.5.2 - Credit Card Companies

QA

6.4.

QA

Reviewed ”~

TestDirector

26  “* ”” Generating Reports 27 <~
77 Generating Graphs

12 = > Linking Tests to
Requirements

TestDirector
The Requirements Module
The Requirements Menu Bar

The Requirements Toolbar

The Requirements Tree

——1 50
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7.1.

View

Requirements
menu bar
Dacument View —

TestDirector Requirements
Document View Coverage
Microsoft Word Excel
TestDirector
TestDirector TestDirector
TestDirector Installation Guide
I Prsjoct | TastBirecter_Bems [admin [REGT PLAN [ TE5T Ll | DEFECTS | oos RSN Looosr |

Cocument Wiy B

EE O, 4 - ¥ a-f 20 450 6

Requirements j

tiara 4 ]| Cover Steus | = el | e | Rensermd | Grestion T
=1 - M eniry Tanms Bjojsa:alion X paied (R0 [ Foa st L0730 4
toolbar = 1.1- Ouling Trovel Booklsg Serdcas. X raie |rcoo4 s [— B4 206 Ak
= 114 - Prothicis Serdces OnSale X Faed [lieaiis | wa_td Mayimemc LERRLIEY]
Reqidrements — 1121 - Right Tebatz X Foied (R0 ksl Ravirad 104 515 AW
tree 1112 - Hobel Rezernfions 2 Mok Covered (R0 5] rhe Hit R e 104 167 B
144 3- Cor Manislz ¥ Hotoovered R0 sz td il P i nd 10 24 AW
111 A - Towrsir ulses 7 Mol Coverstd M| b= Tt e e 10T AW
4 1.2 - Omling Traval Dfsrmation Sour—. @ Heb Covred [0 st Hit R e B144E a4
13- Frofireg X Fakd [z sz td Peayremc B1ESE AN
52 Bl oniom S X raen A0 s e wEwed 11506 Pl ‘
Description tab —| T ey
History tab TS EEEEREEN
Fiakd ko [enpa Cutn Jonancar iz aka |
Civoes Biaba DNNENIE F2FE2PY cedlhl Fdel
fCover St I2O0ENE 2 100FY _ceal d Fadacl !
® & E

Linking Test to Requirements

Requirement,
menu bar Fr—
Coverage View —[ (o =
= 1 -Mercwy Tours Bpplcation | Exmcution cute [ o
Requirements =4, el Ty i) Bl i Sendtivn i
tooibar B L1 - Prodicts Sendees OnSala =
111 1 - Aight Ticb=t= (==
111 2 - Holal Frasar-utione: H V2200 1OSEA P oeo
144 3. Cor Ranisis NWIFE0H T4EX A cmc
RE‘W”E‘mE‘ﬁ'U — 144 A - Towrncrums | V2S00 11462 O |pss
tree 51,2 . i T el Rlaimation Soiiice
13- Profng
E 2 - il atiom Secmity
Tests Coverage ot Atz
tab 211 amnmers W Ske Vo
1.2 - Cn_miomar So-ericston
21,3 - Ui e Cisbamer D
Details tab — | 522 sooms lianenessio
2 53 . Preovcy Py otection
=34 - Dt Siaaga Protaction

——1
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Requirements Menu Bar

Requirements Toolbar

View Box

Requirements Tree

60 The Requirements Tree

Description Tab
Show
History Tab

Tests Coverage Tab

Details Tab

Requirements

Mail
View
Tools
Analysis
26 “ ”” Generating
Reports 27 “e

Generating Graphs
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i
New Requirementsita
TestDirector

)
New Child Requirements! -z
TestDirector

Cut dt
Paste

Copy

TestDirector

Paste Paste

Paste

Delete =
Refresh Selected = |

Refresh Selected

Refresh Selected

Select Columns

Zoom in T

Zoom In

Zoom In

Paste

Paste as Child

Refresh All

Zoom Out One Level
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7

o Zoom In Zoom Out To Root
® Find 2

® Mail Requirement% Mail

® Attachments a

Adding Attachments

® Test Coverage

Associated Defects

4.

TestDirector

Attachment NI TINPPINEE
Author
TestDirector
Not
Covered
Cover
Status Not Covered
Failed
Failed
Not Completed
——1 54
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Not Completed
Passed
Passed
No Run
No Run
State
12 “ ”7 Linking Tests to
Requirements
Creation Date
Creation
Time
Modified
Name
.. Level 1
Priority Level 5
Product
ID Req ID ID TestDirector
ID
Reviewed
Type Hardware Software
24
TestDirector
TestDirector Administrator’s Guide
o Creating a Requirements Tree
o Finding Requirements in the Tree
) Viewing the Requirements Tree
[ Viewing Requirement History
[ Mailing Requirements
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[ Viewing Associated Defects
[ Modifying the Requirements Tree
[ Creating Test from Requirements
8.1.
TestDirector
TestDirector
Document View
Coverage View 12 “
”” Linking Tests to Requirements
8.2.
) =
1) New Requirement Car

Requirements > New Requirement.

Requirement

TestDirector ““New Requirement””

1

New
oK
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L EBroject; Tesifivecior Me=y |ad=in]

TEST PLAN [TE5TLAD [ DErecTs | Toous_RRERNN Locowr |

[ R . |

B dmB-¥ b-H -2 Hila

e 4| f} | cover Tmtur | P | e | Rl | Crmabon Tine
= & Merowy Toms Applicaton X Faini =0 | sz _ld Raviawad EIF 2 AW
® e Onlne Tewal Bookig Sendeas » Faisd |Pomacs] ket fil Pz wonal Eoii:Ded AW
& e Onlne Trawsl hfsnmeation Sowce T ok sl | FeznnZe] et Hed Rarcirend E134E AW
= Froiing X rammd L] s il Feaesismisil RS AW
¥ e Applicoliss Secur iy ¥ Faied | Rz [ PRaviavad 1: 1% 0 PTA
Fow Applicoties Clon Sysiaim X Fuimd |ma0342] ohe by bd Pazses el H: 21554
® & Kpplcaties Dabilty X i |REME] thaly bd Pavawad LTS AN
T ow R oniem PrarTel e X rami | RG] ek Pz winal NI AN
B # Applsalies Relinklig + Pagsail |RaT] haly bd Faviawad 113505 AH
w w Ppofie Mon e X rai | ] et R sl 21X Al
# & Bookiw System X Faied | R0 wec jd Fezwia wad LaERER]]
* o Flins Feseraiies Sice X rais |Ra0111] el Ferwial LTS3 AN
New requiremant ___ » (SIS | = e |RE0114] sy Kol Rereserrat 1247 P

|
2) Enter
/ N *
~ & % H
7 The Requirements Module at a

Glance
4) Description

5) Attachments View > Attachments
URL
TestDirector

g -

”7 Adding Attachments

6) Tests Coverage I@ View > Tests Coverage

12 == >” Linking Tests to Requirements
7)

i
o New Requirement E
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s
° New Child Requirement L

8.3.

TestDirector

67 = &
Viewing the Requirements Tree
1) Find o5
Find Find Requirement
Find Requirement
Find in Figld: |Name |'|
“alue to Find: | |
|};' Firicd | | Cancel |
2) Find in Field
3) Value to Find
Name Value to Find
Priority Value to Find

4) Find TestDirector

Go To

8.4.
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1)

2)

TestDirector

v

Zoom In

Zoom In

Zoom In

View > Numeration

Zoom

Zoom Out One Level

Zoom Out To Root

TestDirector
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Refresh Selected

60

o
E—j -
) Refresh Selected Refresh All
o
Expand
o =
Collapse
27 = &
Filtering Records
8.5.
1)
2) History
L Description VTR
Fil | <Al -]
Field Mame |I:hange Date |Ehanger Mew Walue
Cover Statuz 0840742000 17:00:17 Abs admin M A2,
Reviewed 0743142000 12:0316 Pk admin
3) Field
C——1
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TestDirector

TestDirector Administrator’s Guide

8.6.

E-mail TestDirector

TestDirector HTML E-mail
TestDirector Site Administrator  Site
Config MAIL_FORMAT
TestDirector TestDirector Administrator’s Guide

1) Mail Requirement b=
Send Mail

Send Mail
v |

2 To.. |

|@ Co... | |

Subject: |

et

(6] 708 - Ul Checking Operations

Imclce: [ Attachmerts [] Histary [] Tests Coverage

Additional comments:

| Send | | Custam... | | Cancel | | Helg
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2) E-mail To Cc
Select Recipients

Select Recipients E

Available Uzers: Mezzage Recipients:
€& [Developer] - ;I
B Dod]
€& [Project Manager)] 4
B 2s Manager]
£ (24 Tester)

B [RAD Manager]
& [TDAdmin)
£ [Vieweer]

& admin (TestDirector Administrator)
7 alex_td (Project Manager) —
7 alice_td (24 Tester)

72 cecil_td (24 Tester)

£ guest (TestDirector Yiewer)

7 james_td (Developer)

hd|
| Ik | | Cancel
OK
Properties
TestDirector

TestDirector Administrator’s Guide

3) Subject
4) Attachments History Tests

Coverage

5) Additional Comments

6)
o Check Spelling v
Spelling
° Spelling Options [
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TestDirector

o Thesaurus
7) Custom E-mail
8) Send E-mail
8.7.

12 “ 7
Linking Tests to Requirements
108 ““Associating Defects with
a Test”” 196 ““Running a Test
Manually~~

View > Associated Defected

Associated Defected
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Aszociated Defects
Columns. ..
| Test Mame |Defec1 (0 |S‘tatus |Summar':.f |
H‘I.-'"-.I'elu:u:-me Page izz Open U=ser Mame and Password fields have ac
Wielcome Page 23 Closed The password iz not encrypted when ins
Wielcome Page 24 Open = tags have noWIDTH, HEIGHT and AL
Wiglcome Page 25 Open Uzer Mame and Passwoard fields are unlin
Registration Page |25 Open The default value of & Country list on the
De=cription:
Test Set: Mercury Tours L H
Test: [1Melcome Page _I
-
RE&D Comments:
=
=

8.8.

1)
2) Rename
3) \ A *

4) Enter
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1)

2)

3)

4)

5)

1)

2)

3)

4)

Copy

TestDirector

Paste

adds_Copy

Paste as Child

Paste > Paste as Child

Yes

Cut

Paste

Cut

Copy

Paste
Paste > Paste

TestDirector

Paste

Paste
Paste > Paste
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o Paste
Paste as Child
Paste > Paste as Child

5) Yes
1)
2) Delete = Requirement > Delete
Delete

3) Yes
8.9.

o Convert Requirement to Tests

77
Convert Requirement to Tests
o Generate a Test from Requirements
81 Generate a Test

from Requirements
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1)

Tools > Convert to Test > Convert All

Tools
> Convert to Tests > Convert Selected

Step 1

B Step 1 of 3: Choose an automatic conversion method

Convering.  Application Client System

Automatic Conversion Method:

i@ Convert lovwest child requiremerts to a Req 1
design steps. (= ¥ Req 2

L B R 3
1 Convert lowwest child requirements to a Req 1
tests. EIE Redq 2

_1 Conwvert all requirements to subjects. 'S Reg 1

|| Memts | Cancel || Help

2)
o Convert lowest child requirements to design steps
o Convert lowest child requirements to tests
————1
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Convert all requirements to subjects

3) Next

Stop
Step 2

B Step 2 of 3: Manual changes to the automalic conversion
Converting:  Application Client System

Auto Complete Children

Eaflu || 8| B | X
Mame
= 77 Application Client System
= [ Hardware
M Processar
M Memory
M Wirtual Memary
M Disk Space
Eu  Monitor
& Size
& Resolution
¥ Internet Connection Speed
M Printer
E [ Software
Eu  Operating System
& Microsoft Windows

< Previous || Mewxt » |

Legend

IS I=] E3

| Cancel | | Help |

4) Legend
5)

° XExclude

XExclude
[ (ISubject
ISubject

— 1
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] M Test
M Test
) ¥ Step
¥ Step
° B Desc
B Desc
6) Auto Complete
Children
7) Next 3

B Step 3 of 3: Choose the destination subject path

Converting.  Application Client System

Destination Subject Path:

Subject L

|<F'reviu:uus || Finizh | | Cancel || Help

8) Destination Subject Path Browse Select a
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Destination Subject

TestDirector

9) Finish Stop
3
10) OK
1) Generate Test
Generate Test
Subject |Subje-:1'l.Tempu:urar':.-' Tests -

Test Mame : |.ﬂ-.ppli|:ati|:|n Client System |

Create Design Steps

[] Add Test to Test Set

TestSet  |defaut [~ |

| Ok | | Cancel | | Help |
2) Subject
TestDirector
3) Test Name

TestDirector

4) TestDirector Create Design
Steps TestDirector
5) Add Test to Test Set TestDirector
Test Set
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6)

OK
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Mercury SiteScope

SiteScope

Part 1|

1 SiteScope

Mercury SiteScope

Mercury
SiteScope

SiteScope
5,000

rogerw (rogerw.hai@gmail.com)

24x7 Mercury
SiteScope
Mercury
IT
SiteScope

Mercury BAC, MMS, LoadRunner

SiteScope

CPU
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1.1.SiteScope

Mercury SiteScope

Failover
SSH Mercury
SiteScope 65
(threshold)
SiteScope
Website URL URL
Link SiteScope E-mail SNMP
Trap Pager ( SMS ) Post DB
alerts
SiteScope
SiteScope Windows UNIX Linux
SiteScope

Windows UNIX Linux

1.2.SiteScope
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L=

Browser
SiteScope o
AN —
“v_E R
Scheduler Configuration
'¥
Infrastructure = -
Maonitors ﬁ
Logs %
WebPages
| —
@ {ﬁ
Alerts Reports
Email, Pager,

1.3.SiteScope

SNMP, SMS, Web Services,
Corrective Action

SiteScope Server System Requirements

Computer
Processor

Operating System

Memory

[/ Pentium IIl, 700 MHZ+ or

Sun Ultra2/E220/E250

Dual processor machines recommended for more
than 4,000 monitors or 500 monitors per minute.

Windows 2003 Server and Windows 2000 Server
Solaris 2.7, 2.8, 2.9

RedHat Linux 8.0, RedHat Linux 9.0 with Native
POSIX Threading Library (NPTL) and RedHat

Enterprise Linux 3.0

RedHat 9.0 with NTPL or RedHat Enterprise Linux 3.0
recommended

512 MB RAM

2 GB RAM recommended for more than 4,000 total
monitors or 500 monitors per minute
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Free Hard Disk 1 MB per day for each monitor per minute.

Space
For example, 10 monitors per minute will require 10
MB of disk space per day.

Mercury SiteScope Mercury
10 demo.sitescope.com
demo.sitescope.com

SiteScope
2 SiteScope
Mercury SiteScope for Windows
for Linux Mercury SiteScope Apache JRE
web server
SiteScope SiteScope
SiteScope
License license
SiteScope
SiteScope Web
Site site
SiteScope
1.
2.
Web URL

Apache

System Monitors Web/URL Monitors
(1 point each unless (1 point each unless otherwise noted)
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otherwisenoted) |

CPU Utilization Link Check

Database URL

DHCP URL Content

Directory URL List*

Disk Space URL Sequence*

File Web Server

IPMI* Web Service

LDAP *1 point per step or URL

Log File Application Monitors

(1 point per metric measured unless
otherwise noted)

Memory Apache Web Server

News ATG Dynamo Application Server
Network BEA Tuxedo

NT Dial-up BEA WebLogic Application Server
NT Event Log BroadVision Application Server
Radius CheckPoint FireWall-1

Script** Cisco Works

Service Citrix MetaFrame

* 1 point per metric IBM DB2

** 1 point for first four values
matched. 1 point for each value
thereafter.

IBM WebSphere Application Server

Network Service Monitors [JgsR=1sBIx

(1 point each unless
otherwise noted)

DNS MacroMedia ColdFusion Server

Formula (Bandwidth) MAPI

Composite

FTP NetScape Enterprise/iPlanet

Mail NT Performance Counter (Microsoft
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Applications)

Network bandwidth* Novell SilverStream

Ping Oracle9i Application Server

Port Oracle JDBC

Real Streaming Real One/Real Media Player and Server

RTSP (Real Time Streaming SAP GUI

Protocol)

SNMP SunONE Server
SNMP by MIB** Sybase Database
SNMP Trap Windows Resources*
* 1 point per interface * 1 point per instance

** 1 point per metric

100 10
5 10 X 5 =50 2 URL
10 2X10=20 30
1 30 X1=30 100
10 1 10 X 1 =10
URL 5 1 X5=5
85 85
3 SiteScope
SiteScope

SiteScope Homepage Alerts Reports Health
Preference Help

3.1.
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@] http:/Awww. sitescopedemo.co.uk - Agentless Monitoring - : SiteScope - Microsoft Internet Explorer

Edit Tools

File

Wiew  Favarites

? Google- |

vig - B

© 3 A-4.

Scopefhtdocs)Sj oo bl

e Monitors/Groups Browse

Remote UNIX

Remote NT Tools

ate Graun

REeset Demo e

EUEK

@ Internet

3.1.1.Multi-view

5

|

% T E‘ -'.:'

2 e e 3 8-

@] http://demo_sitescope.com - SiteScope Overview ... |

Namaiil)

@ htt|3:,l',l'clemo.sitescope.com,l'SiteSc0|J|3,l'htclocs,l'SiteScope.h”E

Manage
Monitors/Groups

SiteScope Main View

ate Group

Application Monitors

AS400 4 TS
SP Sewiﬁggf{%%%m

PBctive Directary

fpache Server Monitor

hstra Load Test

Lisco Router

Exchange Mail System

L5 Big 1P

Oracle Stats

Oracle Solution Set Template
Standard Oracle Monitors

SOL Sepver Peffomance

Wehb Server Monitor

Weblogic Applimtimﬁﬁﬁﬂﬁmﬁ
Websphere Applicatiff & E 2 FgtrEY
= Best Practices
= Applications
B www.mercuryinteractive.com

A

% Internet

0 Internet
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Multiview Manage Moniton

ﬁESiteScope Sitel » |

Iﬁﬁi‘]‘_Muln wiewHUd RHY

ko

HJGroup/Monitors ° ﬁﬁ’

Crone

| ress Slll‘lllllﬁl!

fdblack

will update monitor Failover:3 Reset Mercury Application Management / Copy Config upon
Primarv Startup_in 12 seconds

Sidblack:

Ereipisssii i e e
Multi-view Manage Browse Remote Remote Tools Progress Summar
—————  Monitors/Groups —— UNIX NT ‘ = L

SiteScope Server List

N

Del

{92.168.0.4:6000 !

9RL1E8.0.5:8800

Multi-View Preferences

Mumber of
Colurmns:

Refresh Rate; B0

Multi-view Wmdow tunlhar—nn swidth=400 height=400 directories=no status=no scrollbars=yes resiz:

Optian
Table Options: borde=0 cellspacing=0

Background Color; #100000

Update | the Multi-view Settings

3.1.2_Manage Monitors and Groups

error/warning/good

1

79



www.51testing.com

Filter Settings:

ettings:

Match Machine For Maonitor Type: | All types __‘_M Apply F
e — T
+ = 3
- GERLESRRLRRTIRARY
#[[]Advanced Monitors s Y e © il gess
Pl Regular Expression o if4l#HH
+ [7] Application Monitors BEEEE Y -
+ [[1Best Practices
+ []DemaGroup
+ [[]Metwork Services
+ [F] System Moniters
For groups, make the selected groups a subgraup of another group
Far monitars, move the selected monitors to a different group.

Far groups, capy the selected groups and subgroups.
Far monitars, copy the selected monitors to a different group.

Duplicate For groups, copy and rename the selected groups and subgroups

Faor monitars, copy and rename the selected manitors

Far groups, delete the selected groups and subgroups.

For monitors, delete the selected maonitors,

For groups, disable all monitors or alerts in the selected groups and their subgraups.

For monitors, disable the selected monitors or alerts

For groups, enable all manitars or alerts in the selected groups and their subgroups.
For monitors, enable the selected monitors or alerts ﬁgﬂﬂﬂﬁ -

Reftesh Far groups, refresh all monitors in the selected groups and their su e e -

For monitors, refresh the selected monitors. g%%%%%%%%é%%%k%g%@@gg
b:
g 3 — H{fi:E » error/warning/good

Ranl ELEE o XA —Hy glg

Replace values in the selected groups and monitars P A E RS o
@aselme Establish a fixed peformance baseline for the selected monitors
__,—u—l——'__"-

3.1.3.Browse

<< Hide Contrals ]

hatch
Status:

duplicate Refrash ;Manual refrash

[s| Match

Mame:
fatch Update and Ref
Machine:

Browse Monitors (1 out of 320)

Use the Monitor Description Repaort to view current maonitar configuration settings.

State Status Name Group |Edit Refresh Documentation Machine Updated Alerts Reports
duplicate sub-tag
"_name’s for Master g
_remoteNTMachine |file Health |[Edit [Befresh P &

tag in master.config |Checker
with value: "

3.1.4_Remote UNIX/NT

Telnet
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3.1.5.Tools
SiteScope
Application Diagnostic Tools that operate as a client application. il
Check FTP Server Check whether an FTP file can be retrieved.
Check URL Sequence Retrieve a sequence of URL's.
DME Lookup Test a DNS to see if it can resolve a domain harme.
Database Connection Frovides an interface to test a JDBC or ODBC connection to a database.
Gat URL Reguests a URL fram a server and prints the returned data.
hail Hound Trip Test Test a mail server by sending and retrieving a test message.
Ping Performs a rmoundtrip test on the netwark.
SHP Wialks an SMMP mib.
ShMP Trap Display the log of SMMP Traps received.
SHMP by MIB Browses an SMWP MIB.
Web Service Monitor Test availabitliy of a SOAP Web Serwice.
Server Tools show server statistics.
Metwork Display the server's network interface status and active connections.
Semices Shows a list of currently running Services.
)
< B
3.1.6.Progress
SiteScope SiteScope
SiteScope Progress Report 2
tlonitoring Load
h Per Minute Monitors Running Monitors Waiting
tent (22,40 1 0
imurm (25,40 at 07:39 070640 40 at 05:36 070605 |44 at 05:36 07/06/05
Waximums are S Startup at 00:27 070605
Recent Monitors
Date Group Meonitor Status
323305 F5 BigP ;ﬂ]‘}:j}‘r:p Size starting the monitor update. .. (previous update at 02:00 07,/06/05)
09:10 . Router Bandwidth . . ) .
O7/0RM5 Cisco Router Utilisation good, Monitored interfaces: Seriall: up
09:10 . Total Cached . . _
O7/0RAS F5 Big-IP Memory good, Arnount of memory swapped in from disk (kB/s) =0
03:10 ) SiteScope Sener )
O7/RA5 x-debugging Metwork Trafic good, 1K infsec., 3K outfsec., 0.00 packet errors/sec., 50 current cor
0o:09 TCP :
) Metwark Card Activity Connections good, Connections Reset: = 16277
07/06/05
Reset
030 #-debuggin Java Handle Count|good, Handle Count:java = 1910 ]
n7nRMA gging gond, ] ¥
< ¥
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3.2.Alerts
““Alerts”” SiteScope
alert
Multiview Manage Monitors/Groups Browse AddAlert Disable Alerts Enable Alerts Alert Report fad|
Alert Definitions
On Group For Do History Edit Test/Del
error at least x rrultiple Send Mail to ShortSubject . :
4, ewery 40 rronitors peherry@ mercury. corm History  Edit Test =
error at least x Application rrultiple Send Mail to ShortSubject . :
1, every 10 Manitors: AS400  monitors Mancy.Finkig@comteksenices. com Histnry  Edit Test &
Alert Actions:
Add Add 3 new alert for ane ar mare monitars or groups
Dizable Dizable all alerts
Enable Enable all alerts previously disabled
Test E-Mail Send a test E-Mail Alert using current E-Mail Preferences
Test Pager Send a test Pager Alert using current Pager Preferences
Test SHMP Trap Send a test SNMP Trap Alert using current SMMP Trap Preferences
Alert Report “iew a report of alerts that have been sent
Alert Log “iew the the log of alerts sent
RCDALIDV™ v
[ ¥ Add >y
Add Alert
Alerting on: Choose the monitor status that should trigger the alert
@ Error ' Waming Dﬂk
Alert Type Choose the type of alert to create
@ E-Mail Alert Sends an alert message via e-mail. Help
) Pager Alert Sends an alert message via a alphanumeric or numeric pager. Help
() Script Alert Runs a shell script on this machine or a remote machine. Help
) SNMP Trap Alert Sends an SMMP trap. Help
) Sound Alert Plays an alert gound on the machine where SiteScope is running.  Help
{ Define Alert '
B —
Advanced Alerts For specific needs of complex environments and may require additional se
() Database Alert Send an alert to a database by calling a stored procedure or Help
inserting a record

““Define Alert””
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Define E-Mail Alert on Error ]

Alert Subject(s)

All Groups

|Health {__Haalth__)

I Advanced Monitors (Advanced_Monitors)
Application Monitars (Application_Monitors

pplication Monitars: ASF Server (ASF_Server)

Select the Groups and Monitors handled by this Alert. To select several items, hold down the Control key (on most
platforms) while clicking item names.

Send Mail (Edit E-Mail Freferences) Tao

<] ; 3
““Edit E-mail Preferences?” Email
SiteScope alert Email
E-mail Preferences &

Enter the domain name of the mail server to uge -

tail Server Domain 194 205 110133
Marre: ' for sending SiteScope messages and alerts. This
server should be an SMTP mail server. Far
example, gateway this-company. com.
Administratar E-mail igheaton@mercury—eur.com Enter the administratar e-mail address where 4
Address: ) SiteScope will send status messages. For
example, suppartE@mercary.cam.
SiteScope Status [ Daily Status Select which regularSiteScope status messages -
Messages you would like to receive.

[ SiteScope Starts/Restarts

[optional) Enter the email address used as the
From Address for SiteScope messages. This is
used to make it easier to browse or sort email
generated by SiteScope. For example,
supporti@mercury.com.

From Email Address: iAIener@Sitescopedemu. co.uk

{optional) Enter the domain name of a backup v]

Backup Mail Server }
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AR RIRRRGE R T AR ZER N o

en all monitors
cause an alert

E-tail Alert

BFEIRE R Alent FIZE

imes afterwards

of this group are in error
when all of the monitars in the group are in errar

on occurs exactly this many times, consecutively.

Advanced Options

Digable Alert

® Enable Alert
O Disable alert permanently

minutes vl

O Disable alerts far the next

F S T L VY U WO PO TS [ = B =1 N7 nene

L nam

nrnens |

<

Alert Log

alert SiteScope

i File Edit Mew Insert  Format  Tools  Actions  Help

Fraom: a monitor@sitescope. com Sent: Mon 6/6/2005 17:04

d

Subject:  SieScope Alert, error, B R ot Found (03 (192.168.0.2)

This alert is from SiteScope at http://192.168.0.2:885858/3iteScope #~

Monitor:
Sroup:

Server: remote:l9
Update ewvery: 600
Title:

Verify Error: on

Depends Condition:

Status: not found (0)
Semple #: 8395
Time: 5:04 PM &/6/05
- etail  -—————————————————
Process: ./

Measure Frocess Memory Use: on

Update ewvery (on errors): 150
good

erountr: [EEEEREEE

status: not found (0O)

3.3.Reports

——1

““Reports™~

SiteScope

Alert Report
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report

ZI"Bescope AIBTS |

Multiview Manage Monitors/Groups Browse Progress Summary Add Report Ouick Report

Management Reports

Reports Time Period Edit Del
Advanced Monitors last week Edit ki
Application Wonitors. last week Edit K =
Metwork Services, last waek Edit K
Systern Monitors, last week Edit k

To view managerent reports and summaries, click the link in the Reports column above.

Report Actions:

Add Add a new scheduled management report for a specified time interval i

Cluick Generate a Quick repart far a custom time period and selected manitors

Progress “iew the SiteScope Progress page for monitor load information

MLM ) Generate a report of monitor configuration settings by group or installation

Description 77 77T T T T T TR AR A
™

[ X3 Ad d >

Add Management Report

Show history for the selected items

{|Application Monitors: ASF Server (ASF_Server)

To select several items, hold down the Control key {on maost platforms) while clicking item names.

i[RI EHY ©

Report Sections Select the sections to include in the report

[l Summary of Manitar Thresholds
Summary of Uptime and Readings

[] Count warning time the same as good time in UpTime

Report Sections

report report

Email ““Send Report by Email”~ Email

““ Report
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Schedule”” SiteScope Reports
3.4.Quick Report

Quick Report
““Reports?”

URL Sequence Check
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Warnings from 05:31 01/06/05 to 05:31 08/06/05

Time Meonitor | Status
Mo warnings
First 100 Goods from 05:31 01/06/05 to 05:31 08/06/05

Time Menitor Status
05:39 010605 Log File Monitor 0 matches, 0.00 matchesdmin, 0.00 log entries/min
0540 01,0805 MT Event Log Manitar 0 matches in 1 entries
05:40 01,0605 Mews honitor 0.48 sec
05:49 010605 Log File Monitor 0 rnatches, 0.00 matches/min, 0.00 log entries/min =]
05:50 0106105 MT Event Log Maonitor 0 matches in 0 entries
05:50 01406/05 MNews Monitar 0.32 gec
05:59 01/06/05 Log File Monitor 0 rnatches, 0.00 matchesdmin, 0.00 log entries/min
ME-Nn N nES KT Fuant | an bdanitoe M ematehas in M antriae ["]

3.5.Preference

““Preference”” SiteScope site

-~
Multiview Manage Monitors/Groups Browse Tools Progress Summary
General | Dynamic Update | E-mail | Log | Pager | Schedule | SiteSeer | Mercury Ak | MS | SMMP | Bemote UNE | Remote NT | Users | Recorder
General Preferences
Licens g \ Enter the license number for this copy of SiteScope. The license number is given to you when
you purchase a license and is required after the 10 day evaluation period e
Licefse Status )
Optiordjcenses: / Enter the license or licenses for SiteScope optional monitors. Separate multiple licenses with a
"" {[comma)
Options Enabled S FRE=EMlicense * fiI
SRR A B license
Locale-specific Date and Time Enables the display of dates and times in a locale-specific manner. The default is the United
States format.
See the General Preferences Help page for maore information about over-ridingthe default tire and date locale used by SiteScope
International Yersion | Enables SiteScope to work with multiple character sets. Yhen checked, all character
encodings will be honored (for example, foreign language web pages). When unchecked, only
the local system encoding is honored
Mumber of backups per file Enter the number of backups per file that you would like to keep. SiteScope will name them
with a .bak.1, .bak.2,.. bak.#, where 1 is the lastest backup file
Operator Acknowledgement O Enables Operator Acknowledgement Functionality. Allows users to click on a monitor status [VJ
SiteScope Preference
license 10 license update
license license
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Multiview Manage Monitors/Groups Browse Teols Progress Summary

General Preferences

License Mumber: Enter the license number for this copy of SiteScope. The license number is give

when you purchase a license and is required after the 10 day evaluation period.

License: B Permanent, points: BB, used: 78, options: MQ Status Monitor, Com+ Monitar, Astra Load Test, CCMS SA|
Monitor, Siebel Manitors and Solutions, EMS Maonitors, J2EE Monitors, Exchange Serer, Active Directory, Apache, Ariba, ASP

License Status:

Cption Licenses Enter the license or licenses for SiteScope optional monitors. Separate multiple

licenses with a " (comma).

M3 Status Maonitor, Com+ Maonitor, Astra Load Test, CCMS SAP Manitar, Siebel Monitors and Solutions, EMS Monitars, J2EE

Options Enabled

SiteScope Security and Web Server

SiteScope contains a built-in web server to serve its pages. The options below control the port and the access requirements to the SiteSc
pages may also be served through a standalone, third party web server.

IRAddresses Allowed: ) Enter the IP address that is always allowed

IS T EEP(H1206.168.191. *) » W]
Use a tra”ingRﬁﬁ%ﬁﬂglePﬂmmlﬁlSlleSCope 3. For example, 206.168.191.% allow

subnet. To allow multiple IP addresses, separate them by commas. When using this option, you also
address and Login option below to.

. HiRE M » W& ifklsiteScope Ry H prbh : N
o s son B R VSRR o S e

When this option is turned off, access is allowed to anyone who has either an allowed IP address (as :

Profile (with uzername and password).

SitgEcope Port: . Enter the port number for the SiteScope bui
B i
SR A 8888

Note: Leaving this field blank will prevent SiteScope from serving web pages.

Serving SiteScope through an external Web server

Static HTML Pages | HTFFFEReportakEAlertth rRi%  tion if you plan to serve SiteS
SiteScope Y& N EIPHiHE: o server application.

@s: Ehttpzﬁwww.sitescopedem@bk - Agentless b Enter the domain name or address of the w
{ escopedemo. |

serve SiteScope pages.

3.6.Users

SiteScope administrator
user administrator
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rererences

I SRescope ATaTS Feports HeaMn

Multiview Manage Monitors/Groups Browse Tools Progress Summary

General | Dynarmic Update | E-rmail | Log | Pager | Schedule | SiteSeer | Mercury AW | MMS | SMME | Bemote UNE | Remate
NT | Users | Becorder

User Profiles

Uzer profiles contral viewing and editing permissiong on this SiteScope installation.

FAHF  WRER

Name Login LFFAZE o Edit |Del
e p———— e,
SiteScupWﬂTﬁgtrator J'SiteScope?accounFadrmEWEm{ Edit
SiteScope UZerfdisahled) /SiteScope?actount=usas—" Edit
katirm _____.———-—ﬁ%eﬁtm-?-aemumﬂo inl B — Edit kS
: E SiteScope I i v - =
2 /Sitel ? t=loging Edit #
user. C___‘__‘_—__ Heocope aecoUnt=00in. E%%Eﬁy.;ﬁﬁﬂ ol h
BRI P o

dd Mewe User Profile

MERCURY™

3.7.Configure file

SiteScope

<SiteScope install path>/SiteScope/groups/master.config

Master.config

_urlRedirectMax=10
_URLRemoteLocationsMax=6
_urlRemoteRequestMax=4
_URLSequenceMonitorlgnoreHTMLComments=
_URLSequenceMonitorSteps=20
_urlUnixSSL=
_URLUserAgent=Mozilla/4.0 (compatible; MSIE 4.01; Windows NT)
_userRedirectFile=
_userReportindexHTML=
_userURL=http://192.168.0.4:8888/SiteScope/userhtml/SiteScope.html
_useThreadPool=yes
_verifySleepDuration=5000

Email Alert SiteScope server IP

master.config
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_hideServerInSubject=true

SiteScope
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QA Wizard

sincky.zhang

QA Wizard windows web
.net .net
.net
GUI Seapine
1. qgawizard
QA Wizard seapine

QA Wizard, gawizardinstall.exe
QA Wizard ga wizard

gawizard

run-time gawizard

QA Wizard

——1 91
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rational
xde tester
gawizard formula bar
excel formula bar run-time
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[= Main -
— Open Browser A * Afindowl -
— Mavigate £ * Afindowl * | httpd A, seapine, com
— Mousze Click = Text Field * ufindow] -
— Input = Text Field * ufindow -
— Input e T et Field * ufindowi -
— Input e T et Field * ufindowi -
— Input e T et Field * ufindowi -
— Input = Text Field * ufindowi -
— Select =] Select Contral * Afindowi] * - Mot Set - WipsiCale w
— Input e T et Field ="t =
— Select E] Select Contre (ealy)
— Select E] Select Contre brady
— Input (] Text area ]
— Mouse Click ' Submit Buttor =
— Mavigate = o

action type
type
Step #

object type

Action Type
Object Type
Window
Text

Alias

Description

gawizard

winrunner robot

Workspace

Projects

Scripts

Database Environment

——1

step#

action type

object
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Project Variables

Assemblies .net

Project Explorer - x

Wiorkzpace | Feports |

% Sampl eTorkspace

[ 4 TindowsAFT

@ Scripts

@ Database Enwiromment

£ 4
Seripts

EE Tllatabaze Enwiromment

: E||__=|i| ExcelConnection

. =] Bugs

Project Yariables

[+ & Utilities

[+ A DOT_NET REGVERIFY

[+ 4§ DOT_WET MATLCHECEK

----- 5'@ hzzemblies ( HET Runtime not installed)

gawizard

gawizard

windows tool applications

windows

——1 %4



www.51testing.com

Applications

PR
All

BugReporter

o

F: e ER iR 04 Wizard\BugRepart. exe IT
F RN ERIR DA Wizard I?
-

run
ok

project add new script

Add Hew Seript — WindowsAPT
)

F: e EH R O A WizardsS ampletyforksp

[ ok ]| Cencel |

ok

——1 %



www.51testing.com

5 HDatallriwen

atabaze Enwiromme

roject Wariables
thiz iz gsincky's test script, hahal
tlasz

{ET_REGVEERIFY
{ET_MATICHECE

1 sinckyscript 2
script record

5 ExceptionHandle
H Datallriven

rabaze Enwiromment
rject Wariables Bugh eparter
EmailSender
RegTesterlFAIL
RegTesterlPASs

Choose Application

1es
T _REGVERIFY
T_MATILCHECK

3 record gawizard

web

gawizard
gawizard
cookie
gawizard interactive

silent
suite run

ok

——1 %
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HindowsAFT |

& _SimpleRecor ddndPlay i
_SimpleCheckpoint Add Group
C_RunTimeCheclpoint

I CallingScripts
E_TfCheckontainsStatements

7 Exceptiontandler

H Datallriven

sinckysript

gawizard
gawizard
fail
ok
gawizard ok
1 tool exception handle 2
new 3

manage paths

sinckyexcepkion

oM ORESPACE S
o PPLICATION

SLCONFIGE Script Setkings & &8¢0
P CORMFLZ %, Scripk Exceptions Settings - Path nok currently available
i OMFIE %
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EE Image - (Static)
.]¥] As Static - The Following Figld(s)

5 action

gawizard

=-J%¥ 8| BugReporter - (#32770)
# O
EE Image - (Static) Eutton - FA5E (Button)
L]V An Static - The Following field(s)

update preview gawizard

script execution repeats
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silent mode exceptions
caching
cache error handle
run

Fun Manager

sinclorgroup Do not deleta

EugReporter
WebException
sinckyexcept|

save batch

window

Sawe Batch l_

leard"\SampIeWDrkspace'\Sample‘v\-"curkspace qawbat l_

|7 F: R ER iR 04 wizardsS ampleWnrkspau:e"-.S anmn I_

gawizard
pass fail
xml
Qawizard TestTrack Pro seapine

TestTrack Pro

——1 9
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summary
TestTrack Pro

XA scopie

Time
Seripl ol Fead
San | End | Total | steps BUmmAny
h I ok ¢ | Weind cravs AR | sincloysnpt | 0003852 00U FCNE 0000021 30 30 0 LG
i'sulrp WOk IpAac | veind e mkysnp ] E
action type
lteration f Step F Object Type Source Variable Description Execution Ti
M Loop
o 142 W Eun Application ablg i A1 =sincky surmary 00:00:03
¥ Type Text
[T Mouse Click ) E1=sincky
@ 1410 ™ Select Edit compaonent 000000
[T Close Application|
@ 1712 I Select Al Edit F1=10 00:00:00
Gl=sincky
@ 1/14 Type Text Edit deseripiion! 000000
) 1417 Type Text Edit IT=ck 00:00:00
@ 1/19 Type Text Edit J1=sincky steps. 00:00:00
B7|5E| & ‘&l Bl»)l
gawizard
record
gawizard
yes
add comment line description
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gawizard

tools options
scripts gawizard

[ hetion Type
. Object Type
E'l'l'indnw

EText

Do not delete x| step 7]
B:E )

add statement instruction text delay 5000
add

hdd Statement

at L |
I =

sk Cal
- H] Colurnn

function builder

——1 101



www.51testing.com

delay
Funection Builder

DELAY [smilisecs]|

R T I I I I T N et |
Functions BROWSERWIMDOWSIZE
Operatars Date & Time CLEARHASH

Consgtants Cammar COMPUTERMAME
b athematical DECIMALSEFPARATOR
Text
D atabaze GETCURDIR
GETEMY
ITERATIOMN
LESSREGE=

wait for object qawizard
for for edit statement

l—}[u:\use Click shEdit - FugKeporter -
Hame:
CRindow FugReporte:r =

) L |
TMETERATIONWait oGt . |

WwaitForObjectd175 [0 =
L]

add command

——1 102
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Select Command

Checkpoint
Claze YWindow
Expand [Collapze]
Highlight b e

statement

Add Statement

Continue
E xit

add

Qawizard

a block steps
add
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P
|.@Q =

windows

e

element tree

gawizard

lement pointer

select html object

select element

Select

EITab=s Control. Label - FugReporte:  Ee
Mouse Click whl Edit w Eugleporte: -
Trpe Text s Edit w Eugleporter » ok
Mouse Click s Edit » Fugleporte: -
Trpe Text sl Edit w Fuglieporter » (=i
Mouse Click O Button + Fuglieporter » (&5
|
H I i)
Trpe Text Selact Trpe Text
wHEdit [MTab=z Control. LE I
Talue Talue Talue
iin zincky descrip » Reproduce - &

ok

add row
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number

date

time

text

currenty

percent 0 100

1 format

Fl:l "mat |:l'-_-ll
e BugR eparter

BugF eparter
BugF eporter
BugF eporter
BugReporter
BugReparter
BugReparter
BugR eparter
BugR eparter
BugF eparter
BugF eporter
BugF eporter

-
-
-
-
-
-
-
-
-
-
-
-
-

LEEEEEE BE BE FEBERE EE BE BE RE |

Twpe Text
o ablE dit

gawizard
1 2 object type
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T abz Control.|con ﬁBuaHei:Drter v Jl I |
¥ ﬁl M arnme | YW alue | Wariable Mame | 2, | El [?ﬂl &’al _.‘;._1|
11 B window
Contral Id 2598 W ||
Dizabled falze W T i
T ab Order 14 W ICOC
Vizible brue mlimlinlinlln =
Window Class SysT abControl3Z2 W ||
= Whindow Text OO0 O L.
El Cormmand i
[tem Id miimiiEiiEiln o]
Yalue LTI (T [ E
Attributes 4 Search Order A, Bind Options 4, Object Options 4, Dptions / | | - An Static
3 variable
gawizard

function builder

Function Builder

innillerEwyzicarp. o

SR I A T I 8 3 I S T N A A A nsert_|

Functions Corversion ARRATYCLEAR -
Operators D ate & Time ARRBAYSIZE
Constants g BEEF
b athematical BETWEEMREGE:
Text BROWSERWINDOWPOS
[ atabaze BROWSERWIHDOWSIZE
CLEARHASH
COMPUTERMARME
DECIMALSERPARATOR
DELAY |

] I Cancel |

insert

microsoft excel

41 j@WEB - HTML|
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object type

-

- ;"v'-u-"inu:lnwﬂ

-

Winduwﬂ

-

hittp: L Aenans, seapim

 Mfindowi

hitp: £ Asana. zeapine. comdwysicorpdreportbug, bl

| hitp: /Ao sEapin

options

gawizard

Attributes
Format
Contains
Child count

Focus

command

3

navigate from script

title id

2
checkpoint

web

add
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Select Command

L=t L

Claze YWindow
Expand [Collapze]
Highlight b enu
HScrall

K.ep Press

Line Down

Bugfepoter |8

elements

[P Checkpoint

B[] Window - BugReporter - INTITLED [window)

=5 Dialag [Dialog]
abl Edit - ok [Edit)

ab| Edit - sincky summary [Edit)

Aw Static - Type: [Static)

:I Combo Box - Cozmetic [Combo Box)
Aa Static - Severiby: [Static)

object tree

ahl E.:Iil. - |:||-=:. |E|:|Ir|
Ag  Static - Summarny: [Static)

5 check
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7 ok
4 match case regular
expression variable
check
gawizard
gawizard
sinckyzhang@hotmail.com sincky
wizard

1

2

3 .NET SDK

4

5

6

7

8

9 TestTrack Pro

10 source code control

blog

http://blog.51testing.com/index.php?blogld=19
http://www.bonoy.com/blog/index.php?blogld=4
sincky
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